LENESANS Release Note

RZ/T2L Group
Encoder I/F BiSS-C sample program

Summary
This document describes the RZ/T2L Encoder I/F BiSS sample program package.

For BiSS Interface communication protocol specifications and encoder specifications, contact manufacturer
of each encoder to obtain it.

Functionality Checked Device
RSK+RZT2L Board (RTKORZT2L0OC00000BJ)
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RZ/T2L Group

Encoder I/F BiSS-C sample program

1. Package Contents

This package contains the following contents.
The BiSS-C encoder interface of the RZ/T2L supports up to 2 axes, but the sample program supports only 1
axis. To use with 2 axes, modify the sample program to support 2 axes.

1.1 Software

e Source Code
No. Name Version
1 RZ/T2L BiSS-C sample program 3.0
1.2 Document
No. Document name Version File name
1 RZ/T2L Group Encoder I/F BiSS-C 3.00 (j) r11an0723jj0300-rzt2l.pdf
sample program Release Note (e) r11an0723ej0300-rzt2l.pdf (this document)
2 RZ/T2L Group BiSS-C sample 3.00 (j) r11an0722jj0300-rzt2I-biss.pdf
program Application Note (e) r11an0722ej0300-rzt2I-biss.pdf
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RZ/T2L Group Encoder I/F BiSS-C sample program

2. File Structure

The file structure and contents of this package are detailed below.
Top
— r11an0723jj0300-rzt2l.pdf
F— r11an0723ej0300-rzt2l.pdf
L— workspace
— Software
| — iccarm
| | L— RZ_T2L_biss.zip : RZ/T2L BiSS sample program set (IAR)
| —gcc
| L— RZ_T2L_biss.zip : RZ/T2L BiSS sample program set (e2 studio)
L— Documents
— r11an0722jj0300-rzt2l-biss.pdf
L— r11an0722€j0300-rzt2l-biss.pdf

The file structure of the RZ_T2L_biss.zip is shown below.

Top folder
— configuration.xml : FSP Configuration data
— ( Environment File Depending on Build Tool )
L— src
— hal_entry.c : BiSS-C sample program
— ssi_main.c : BiSS-C sample program
— siochar.c : SCI_UART sample program
— siorw.c : SCI_UART sample program
— sio_char.h : SCI_UART sample program
L— drv
L— biss
— iodefine_biss.h : BiSS register definition file
F— r_biss_rzt2.c : BiSS driver file
— r_biss_rzt2_config.h  : BiSS driver file
— r_biss_rzt2_dat.h : BiSS driver file
F— r_biss_rzt2_if.h : BiSS driver file
— r_biss_rzt2_private.h : BiSS driver file
L— bissc
F— r_bissc_rzt2.c : BiSS-C driver file
— r_bissc_rzt2_config.h : BiSS-C driver file
F— r_bissc_rzt2_if.h : BiSS-C driver file
L— r_bissc_rzt2_private.h : BiSS-C driver file
R11AN0723EJ0300 Rev.3.00 Page 3 of 10
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RZ/T2L Group

Encoder I/F BiSS-C sample program

3. About BiSS Sample Program

This section contains information necessary to use the complete set of BiSS sample program.

3.1 Software Information
3.1.1 Base OS

This sample program is OS-independent.

3.1.2 Memory Size

Memory size used by this sample program and BiSS, BiSS-C driver is shown in following table. This table
does not include memory size used by Flexible Software Package or C language libraries of the compiler.

ltems Memory Size

EWARM e? studio

[kBytes] [kBytes]
BiSS, BiSS-C driver Code 3.9 3.3
Data (with initial value) 0.0 0.0
Data (without initial value) 0.1 0.1
Constant Data 0.1 0.1
Sample program Code 3.1 3.4
Data (with initial value) 0.0 0.0
Data (without initial value) 0.6 0.6
Constant Data 1.5 1.9
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RZ/T2L Group

Encoder I/F BiSS-C sample program

3.2 Hardware Information
3.2.1 Device
RzZ/T2L

3.2.2 Target Board
(1) Board Name

RSK+RZT2L (RTKO9RZT2L0OC00000BJ)

(2) Setting of the Target Board

The target board configuration is as follows.

SW4-1:
SW4-4:
SW4-5:
SW4-6:
SW4-7:
SW5-6:
SW6-1:
SW8-7:

ON, SW4-2: ON, SW4-3: OFF
OFF

ON

ON

OFF

OFF

(3) Used Pins of the Target Board

OFF, SW5-7: ON, SW5-8: OFF, SW5-9: OFF
OFF, SW6-2: ON, SW6-3: OFF, SW6-4: OFF

The correspondence between the pin used as the encoder I/F and the pin header of the target board is as

follows.
Channel Pin name Pin header Input/Output Description
BiSS0O ENCIFDIO (SLO) J26 #2 Input Sensor Data/Control Data input pin
ENCIFCKO (MAQ) J26 #3 Output Clock/Control Data output pin
BiSS1 ENCIFDI1 (SL1) CN1 #5 Input Sensor Data/Control Data input pin
ENCIFCK1 (MA1) CN1 #2 Output Clock/Control Data output pin

R11AN0723EJ0300 Rev.3.00
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RZ/T2L Group

Encoder I/F BiSS-C sample program

3.3 Procedures on Development Environments

3.3.1 Preparation before Executing the Sample Program

This sample program communicates with a PC. The USB connection terminal on the target board is CN16.
The terminal software of the host PC is set as shown in the following table.

Function

Setting

Communication method

Asynchronous serial transmit/receive

Sending / receiving order

LSB first

Transfer rate 19200 bps
Character length 8 bits
Stop bit length 1 bit
Parity function None
Hardware flow control None

3.3.2 EWARM: IAR Systems
(1) Build Environment

IAR Embedded Workbench for ARM (EWARM)

Version: v9.60.3 + patch (EWARM_Patch_for RZT2H_N2H_rev1.0)
RENESAS FSP Smart Configurator (FSP SC) 2025-04.1
RENESAS Flexible Software Package (FSP) for RZ/T2 v3.0.0

(2) Execution Environment ICE
IAR I-jet

(3) Build Procedure for Sample Programs
The build procedure for the sample program is as follows.

1 Copy the extracted source files to the desired location.

2 Activate EWARM.

3 Select [File] menu -> [Open Workspace].

4 Open the extracted source file RZ_T2L_biss.eww.

5 Start the FSP Smart Configurator from the [Tools] menu of the EWARM IDE. *

Note: The following procedure adds the activation of the FSP Smart Configurator to the [Tools] menu of the
EWARM IDE. Select [Tools] menu -> [Tool Configuration] in the EWARM IDE. Select the [New]
button, specify a table string in each field, and press [OK].

Field String
Menu text RZ Smart Configurator
Command $RASC_EXE_PATHS$
Argument --compiler IAR configuration.xml
Initial directory $PROJ_DIR$

String for the command is variable holding the path of the Smart Configurator execution file, rasc.exe.
If the path written as RASC_EXE_PATH in the buildinfo.ipcf file does not match with your rasc.exe
installation path, please edit the buildinfo.ipcf to fit with your installation path.

You can also start the FSP Smart Configurator directly from the command prompt by specifying the
folder where it is installed.

R11AN0723EJ0300 Rev.3.00
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RZ/T2L Group Encoder I/F BiSS-C sample program

6 Inthe FSP Configuration pane of the Smart Configurator, click Generate Project Content. The rzt,
rzt_cfg, rzt_gen, script and .setting folders will be generated.

m C¥1_Prog¥Work¥Work_C¥Work_EWA_980_3_fsp3.0.0¥RZT2L_BiSS_release_chk - FSP Smart Configurator - El X |
File Window Run Help
[RZT2L_BiSS_release_chk] FSP Configuration X = O __“% FSP Visualization =0
Summary Generate Project Content 5
Project Summary ~
RENESAS
Board: RSK+RZT2L (RAM execution without flash memory) .
Device: ROAQ7GO74M04GBG e -
Core: CR52_0 -
FSP Version: 3.00 = e
Project Type: Flat -
Location: C:M1_Prog/Work/Work_C/Work_EWA_960_3_fsp3.0.0/RZT2L_BiSS_release_chk < .
- o
Selected software components T T T I IIr™MIrry
Board Support Package Common Files v3.0.0 = ~ L e
Memory Config Checking v3.00 ws ST S
VO Port v3.00 g . 8 - L)
Fe T .

5 E©) B88esss0500008

Summary BSP Clocks| Pins | Interrupts| Event Links | Stacks Components

uf | § © 0O B Console

No consoles to display at this time.

[ Properties [%] Problems

Property Value

7 When project generation is complete, close the Smart Configurator.
8 Select [Rebuild ALL] from the [Project] menu of EWARM.
The file Debug¥Exe¥RZ_T2L_biss.out is generated.

(4) Sample Program Execution Procedure
After executing the "build procedure", connect the target board and debugger correctly, and perform the
following operations.

1 Select [Project] menu -> [Download and Debug].
2 Select [Debug] menu -> [Execute].

(5) Execution Result of the Sample Program

Run the sample program and enter commands in the terminal software window. For commands, see
4.11.7 console commands in the RZ/T2L Group BiSS-C Sample Program Application Note.

¥ COM4 - Tera Term VT = O X

TPAIUF) REE) ) IVRO-ILO) DAVEDW)  ALT(H)
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RZ/T2L Group

Encoder I/F BiSS-C sample program

3.3.3 e?studio: RENESAS
(1) Build Environment

RENESAS e? studio 2025-04.1
Toolchain version: GNU ARM Embedded 13.3.1.arm-13-24
RENESAS Flexible Software Package (FSP) for RZ/T2 v3.0.0

(2) Execution Environment ICE
SEGGER J-Link™ v8.30

(3) Build Procedure of the Sample Program
The procedure for building the sample program is as follows.

1 Copy the expanded source file to any location.

2 After launching e? studio and moving to the workspace, click the [File] menu -> [Import] and select

Existing project to workspace and click [Next].

3 On the project import screen, select the folder where the sample program was expanded as the root

directory.

4 Select a project, check Copy Project to Workspace, and click [Finish].
5 Double-click the configuration.xml in the Project Explorer pane of e? studio to open it.

a RZT2L_BiSS release_chk - ¢* studio
File Edit Source Refactor MNavigate Search Project RenesasViews Run Window Help
B-A - o i v Q-

Project Explorer X =

~ |55 RZ_T2L biss
njl Includes
8 src

¢ configurationxml
KZ_TZL Diss Debug_Flatjlink

X| RZ_T2L_biss Debug_Flatlaunch
?) Developer Assistance

- [m] *

Q m|[Ecrces
= O Outline X i mil

C
There is no active editor that ‘&=
provides an outline.

Problems X Console Properties Smart Browser Smart Manual 3. O
0 errors, 11 warnings, 0 others
Description Resource Path Location Type
4 Warmings (11 items)
< >
R11AN0723EJ0300 Rev.3.00 Page 8 of 10

Sep 26.25 RENESAS



RZ/T2L Group

Encoder I/F BiSS-C sample program

6

The rzt, rzt_cfg, rzt_gen, script and .settings folders are generated.

Click Generate Project Content in the FSP Configuration pane of e? studio.

Select [Project] menu -> [Build All]

The Debug¥RZ_T2L biss.elf file is generated.

(4)

Execution Procedure of the Sample Program

@) RzT2L_BiSS_release_chk - RZ_T2L biss/configuration.xmi - & studio - ] x
File Edit Source Refactor Navigate Search Project RenesasViews Run Window Help
5 v & - R Q G/
Project Explorer e | [RZ_T2L_biss] FSP Configuration inilen  Outline X &Aa=n0
= Summary There is no active editor that Ly
v 5 RZT2L biss Generate Project Content [l provides an outline
sl Includes i
= Project Summary ~
RENESAS
configurationxml
RZ_T2L_biss Debug_Flatjlink Board: ES‘:(*;?:T:I:I?'{:M ?}(ECIIV\OIT without flash memory)
¥| RZ_T2L_biss Debug_Flatlaunch Buvice SN OOTAMDICRG
Core: CR52_0
?) Developer Assistance z 5
Toolchain: GCC for Renesas RZ
Toolchain Version: 13.3.1.arm-13-24
FSP Version: 300
Project Type: Flat
Location: G:/1_Prog/Work/Work_C/MWork_E2S_RZ.. ZT2L_BiSS_release_chk/RZ_T2L_biss &=
Selected software components
Board Support Package Common Files v300
Memory Config Checking v3.00 v
VO Port v300
>l (?) ¥
Summary BSP| Clocks| Pins| Interrupts | Event Links | Linker Sections| Stacks| Components
Problems X  Console Properties Smart Browser Smart Manual = B8
0 errors, 11 wamings, 0 others
Description Resource Path Location Type
1 Warnings (11 items)

After executing the "build procedure", connect the target board and debugger correctly, and perform the

following operations.
1

2 Click [Debug] to start downloading to internal RAM.

3 Click [Run] menu

®)

-> [Resume] to run the sample program.

Execution Result of the Sample Program

Select [Run] menu -> [Debug As] -> [Renesas GDB Hardware Debugging].

Run the sample program and enter commands in the terminal software window. For commands, see
4.11.7 console commands in the RZ/T2L Group BiSS-C Sample Program Application Note.

Yl COM4 - Tera Term VT
BHES Iv-JKO0)

tart

PIEIW)  ALT(H)
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RZ/T2L Group Encoder I/F BiSS-C sample program

Revision History

Description
Rev. Date Page Summary

0.80 Dec.28.22 - First Edition issued.

1.00 Mar.31.23 - Change description by using RZ/T2 FSP v1.2.0
(Version number of documents, target board name, build
environment, and figures are updated.)

1.10 May 31.23 1,4 Appended section 3.1.2 for memory size information.

2,3 Updated the release note version number.

2.00 May 24.24 2,3 Updated revisions of the application note and the release note.
Updated sample program version to 2.0. (Supported FSP
v2.0.0.)

3 Updated file structure. (Removed RZ/T2L Pin Configuration
data from zip file.)
4 Updated memory size information.
1,5 Updated description of the board name.
Added SW8-7 description in the setting of the target board.
6to9 Updated build environment for FSP v2.0.0. Figures are
replaced.

3.00 Sep 26.25 2,3 Update revisions of the application note and the release note.

Update sample program version to 3.0. (Support FSP v3.0.0.)
4 Updated memory size information.
6to9 Update build environment for FSP v3.0.0. Figures are
replaced.
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General Precautions in the Handling of Microprocessing Unit and Microcontroller
Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.
1. Precaution against Electrostatic Discharge (ESD)
A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps
must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be
adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity.
Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and
measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.
2. Processing at power-on

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of
register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset
pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins
in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the

level at which resetting is specified.
3. Input of signal during power-off state

Do not input signals or an I/0 pull-up power supply while the device is powered off. The current injection that results from input of such a signal or /0
pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal

elements. Follow the guideline for input signal during power-off state as described in your product documentation.
4. Handling of unused pins

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are
generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of
the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal

become possible.
5. Clock signals

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program
execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator
during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.
6. Voltage application waveform at input pin

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between V.
(Max.) and Vi1 (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the

input level is fixed, and also in the transition period when the input level passes through the area between Vi (Max.) and Vix (Min.).
7. Prohibition of access to reserved addresses

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these

addresses as the correct operation of the LSl is not guaranteed.
8. Differences between products

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems.
The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms
of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values,
operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product.

- BiSS is a registered trademark of iC-Haus GmbH.

- IAR Embedded Workbench is a registered trademark of IAR Systems.

- J-Link is a trademark of SEGGER Microcontroller GmbH.

- Arm and Cortex are registered trademarks of Arm Limited (or its subsidiaries) in the EU and/or elsewhere.
All rights reserved.

- Additionally all product names and service names in this document are a trademark or a registered
trademark which belongs to the respective owners.




Notice

1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of
your product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the
use of these circuits, software, or information.

2. Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights,
or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.

3. Nolicense, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics
or others.

4. You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export,
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.

5. You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
6. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for

each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space
system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas
Electronics disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas
Electronics product that is inconsistent with any Renesas Electronics data sheet, user’'s manual or other Renesas Electronics document.

7. No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but
not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE,
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH
RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO
THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.

8. When using Renesas Electronics products, refer to the latest product information (data sheets, user's manuals, application notes, “General Notes for

Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by

Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc.

Renesas Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products

outside of such specified ranges.

Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific

characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability

product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics
products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily
injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as
safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for
aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you
are responsible for evaluating the safety of the final products or systems manufactured by you.

10. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance
with applicable laws and regulations.

11. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.

12. ltis the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.

13. This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.

14. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas
Electronics products.

(Note1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled
subsidiaries.
(Note2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

(Rev.5.0-1  October 2020)

Corporate Headquarters
TOYOSU FORESIA, 3-2-24 Toyosu,
Koto-ku, Tokyo 135-0061, Japan

www.renesas.com

Trademarks

Renesas and the Renesas logo are trademarks of Renesas Electronics
Corporation. All trademarks and registered trademarks are the property
of their respective owners.

Contact information

For further information on a product, technology, the most up-to-date
version of a document, or your nearest sales office, please visit:
www.renesas.com/contact/.

© 2025 Renesas Electronics Corporation. All rights reserved.
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